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1.0 Introduction. 

 
 
Tallies may be connected to the TM1 or to a ESP-1R that is under control of the TM1. 
 
Tallies for the cameras and UMDs etc. may therefore be derived from external inputs from a 
Parallel Input/Output (I/O) interface such as the ESP-1R or may be created within the 
TallyMan program.   
 
Tallies from a vision mixer might not used directly but rather as information with TallyMan i.e. 
mixer status or it may well be possible to use the Tally In interface provided with several of 
the router modules 
 
TallyMan offers Tally Channels (16) to give a tally a second crucial identity in addition to its 
actual tally number. 
 
Previous programs / systems have often provided only two tally channels such as red and 
green.   
 
In some circumstances, both a red and a green tally might have been linked to a router 
source via the tallied router buses – one bus has  a red tally as it goes to air and another bus 
has a green tally assigned to it as it feeds a VTR for, say, behind-the-goal-action – Iso 
recording.   
 
In TallyMan, this idea is extended from two to sixteen channels. 
 
In addition, TallyMan uses System Tallies.  These are tallies that may be made from other 
tallies, possibly using logical operators such as AND, OR etc. to define how the tally inputs to 
the System Tally behave.   
 
In addition, several tallies may be assigned to a System Tally that “belong” to different Tally 
Channels.  In effect, a System Tally may be considered as a “multicore cable” which can carry 
several tallies and tally channels.  In this analogy, these tallies are the individual wires of the 
multicore cable.  A cable with several red cores would have several tallies all belonging to the 
“red” family and it may also have different colour cores, which in this analogy, would be tallies 
belonging to different channels or families.  
 
An output mask is available whereby channels are selected to determine which input tallies 
are actually carried in the System Tally output.  This could vary on a show by show basis. 
 
 
 
It is important to remember that when mapping tallies to objects, (router destination or 
sources) tallies as a rule travel to an earlier source.  So, a tally set to a router destination will 
tally the selected router source which may then be mapped to an output pin.  In addition, 
tallies mapped to a router source will be shown on a destination display because that display 
is showing the status of that router source. 
 
BUT: 
 
If tallies are mapped to a router source, the destination that selects that tallied source is not 
itself tallied and therefore that destination cannot be used to set a tally to an output pin or 
used as a control to drive a virtual tally 2 x 1 router across.   
 
In this latter case, if a Direct Tally is set to the destination, the destination is itself tallied and 
may then be used as the controlling object.
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2.0 Tally Channels 
 
The TallyMan Program has 16 tally channels.  
 
Any tally in the system must be labelled as belonging to one of these channels.  This is 
comparable to that found in other systems (e.g. Winsoft); some tallies might be Red with 
some uniquely specified as Green for Iso-recording.  
 
In TallyMan this is equivalent to Red tallies being labelled as Program (a default name which 
may be user changed) and Green which is equivalent to the label Iso 1.  This is important so 
that groups or Channels of a tally type may subsequently be mapped to UMD LEDs or to 
physical output pins, perhaps via a router destination and hence source.   
 
These individual channels may need to be extracted to unique physical pins for external 
triggering of tally lights on cameras, for example. 
 
It will be seen that each dialog box for routers and UMDs has all the configuring information 
for that item in that box. 
 
 
2.1 Naming the Tally Channels. 
 
 
 

 
 
 
 

Name Tally Channels 
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Click on Name Tally Channels.  Colours may also be assigned but note that only a Tally Out 
Lamp and the Tally Mimic will show these colours.   
 
This screen will now be shown. 
 

  
 
3.0 Tally Inputs – Parallel Interface 
 
A TM1 or TM2 selected platform will set a parallel interface as standard with the Logic Level 
set as the Tally Input type and Open Collector set as the Tally output type.   
 
In general, Tally Outputs will match the Tally Input type selected. 
 

 
 
 
Note:  Additional parallel interfaces are available via the ESP-1/R. 
 
Other types for input for the Parallel Interface. 
 
Tallies from other sources are available – e.g.  tallies from other networked TallyMan systems 
or from, say, an Omnibus engine as serially provided GPIs 
 
Please see Appendix 1 for Omnibus details. 

The tally channels may 
be re-named in these 
dialog boxes. Key in 
the new text. 
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Set the number of tally ins and outs that you need by changing the numbers in the Number 
box and then press Configure I/O. 
 
For a TM1 keep the total tally numbers to 64 and for the TM2 keep the tally numbers to a total 
of 128. 
 
The units are sent out from the factory configured for either 32 in / 32 out (TM1) or 64 in / 64 
out (TM2) 
 
For a TM2 
 

 
 
Changed to 32 in and 96 out. 
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TallyMan system tallies in 
 
This is not the same as a System Tally. 
 
It is possible to export tallies from another TallyMan system serially via Ethernet and receive 
them locally by setting a Tally I/O module to read the remote TallyMan tallies. 
 

 
 
 
 
The TallyMan System ID that is sending the tallies. 
 
 
The Component Import/Export box must be enabled in the main config screen 
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Local system ID. 
 
 
Setting up the Tally Ins. 
 
Select the Tally In list. 
 

 
 
 
A double-click on a tally input will show this dialog box. 
 
 

  
 
 
This shows Tally 1 in from a Parallel I/O interface as having the user-defined Name as 
Camera 1 Red.  It has been set to the Program Tally Channel.  

The drop-down box will 
allow the tally to be 
assigned to a particular 
Tally channel. 
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All incoming tallies may be set to any of the tally channels. 
 
Note: Camera tallies will more normally be derived from information from the Mixer-generated 
tallies.  Please see the section -    6.5  Tallies and Vision Mixers. 
 
The tallies may be assigned to either the left or the right side UMD LEDs as a Direct Tally or 
output to a unique pin on a Parallel I/O interface unit for tallies out to the camera(s). 
 
4.0 Tally Outputs – Parallel Interface 
 
Select the Tally Out list. 
 

 
 
 
 
 
 
Double click on an output 
 
 

. 
 
 
Add a tally to the output. 
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• Select the Type, in this case a Tally In. 

• Select the Parent from the allowable list shown in the drop-down box. 

• Select the Tally number. 

• Click on Add 
 
Click on Finished. 
 
 

 
 
 
This shows that Tally 1 out from the Parallel I/O interface unit has been mapped to Tally 1 in 
from the Parallel I/O interface unit.  As this input tally was flagged as Program, and Program 
in the Active Tally Out box has been checked, a tally is output. 
 
Allow user configuration box has been checked in this example. 
 
For a tally to be output the Active Tally Channel Out box must be checked to match the 
input tally attributes. 
 
Repeat Edit will allow- 
 
Auto Increment to the next Tally Output. 
 
Auto copy will copy the input tally to the next Tally Output box. 
 
Several Tally Ins/System Tallies may be mapped to a Tally Out. 

The Active Tally 
Channel Out area is a 
mask which allows the 
checked tally channel 
type through to the 
Output. 
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The Active Tally Channel Out mask must be set to allow the Mapped Tallies In to be 
output. 
 
These dialog boxes enable User-defined Tally Outs to be made on a show-by-show basis, if 
necessary. 
 
If the Allow user configuration box is checked, this screen is available to all users (non 
passworded). 
 
Tallies may now be mapped to anything that requires a tally; router buses, sources, UMDs or 
Physical o/p pins.  The appropriate mapping is carried out in the respective dialog boxes 
 
Note that a tally output may be mapped to a router destination and a check box may be set so 
that the O/P will show the status of the selected (tallied) source in the same way that a UMD 
would. 
 
 

Check the Bus 
tally shows 
source tally box 
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Tallies also may be entered via the Tally Pin Patch found via Tools > Tally PinPatch. 
 
 

 
 
 
Select the Destination first. 
A click on the appropriate drop down arrows on any valid tally destination will allow tallies to 
be mapped to the correct area. 
A click on the drop down arrow in Source will allow any valid tally source to be selected. 
 
A RH mouse click in the Destination column will show all tallies assigned to this channel. 
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A Shift + RH mouse click in the Source row will show the tally input channel details. 
 
 

 
 
When System Tallies are in use:  
 
 
 
 
 
 
 
 
 
 
 
The orange coloured destinations show which destinations already have other tallies mapped 
to them. 
 
Tip: 
 
Select the Destination for the tallies first and then the available sources will be visible.
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5.0 System Tallies. 
 
System Tallies are tallies derived from other tallies or may be permanently ON tallies.   
 
A System Tally may be regarded as a “multicore cable” carrying, possibly, several other 
tallies, which may be associated with different Tally Channels (Program, Iso1, Iso2 etc.).  The 
Active Tally Output Channel can act as either a mask or as a routing tool, depending on how 
the Output Logic box is set. 
 

  
 
 

  
 
A double click on the System Tally out will show this dialog box. 
 

 

This shows that there 
are two System Tallies 
in this system. 
 
Select the number of 
System Tallies that you 
might need and press 
Configure. 
 

This shows two 
System Tallies with 
the default flag set 
as Program. 
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5.1 Mapped Tallies In 
 
Add Tally  
 
Input Tallies will associated with one of the Tally Channels.  It may be seen that combinations 
of tallies may form a System Tally. 
 

  
 
This shows a System Tally created form a Parallel I/O Interface associated with a System 
Controller.  Parallel Tally In numbers 1 and 2 are OR’d together. 
 
Delete Selection 
 

  
 
 
Use Ctrl and click on the tallies as required to delete the tallies from the input box using 
Delete Selection. 
 

Tally 1 and Tally 2 
have been OR’d 
together to make a 
new System Tally 1 

A Name for the 
System Tally may be 
entered here. 
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5.2 A Permanently ON System Tally. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A use of a permanently ON System Tally. 
 
A permanently ON System Tally may be set, for example to the PGM bus of a vision mixer. 
 
As the mixer cross point selection is known by TallyMan, the mixer sources are therefore 
tallied. 
 
If the  mixer source is linked to a Tally Out pin, the camera may then be tallied. 
 
Also:  A router destination feeding the mixer source will also be tallied (the assignment is 
done in TallyMan) which will in turn tally the selected router source. 
 
This router source is tallied as On-Air. 
 
If the  router source is linked to a Tally Out pin, the camera may then be tallied. 
 
5.3 Comms Status Tally 
 
A System Tally may be used to indicate the status of the serial comms for any object. 
 
.

This shows a 
System Tally has 
been created and is 
set to be 
Permanently ON and 
is allocated to the 
channel called 
Program/Red 
Tallies.   
 
These names may 
be changed freely. 
 
The Configurator 
can allow User 
access by checking 
the box. 

The System 
Tally will be 
active for no 
link and 
inactive for 
good active 
comms. 
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5.3 The Logic Operator 
 
The operators, OR, AND, XOR and the inversion are allowed. 
 
OR 

Tally 1 Tally 2 Output 

0 0 0 

0 1 1 

1 0 1 

1 1 1 

 
AND 

Tally 1 Tally 2 Output 

0 0 0 

0 1 0 

1 0 0 

1 1 1 

 
XOR 

Tally 1 Tally 2 Output 

0 0 0 

0 1 1 

1 0 1 

1 1 0 

 
Inversion 
 
NOR 

Tally 1 Tally 2 Output 

0 0 1 

0 1 0 

1 0 0 

1 1 0 

 
NAND 

Tally 1 Tally 2 Output 

0 0 1 

0 1 1 

1 0 1 

1 1 0 

 
XNOR 

Tally 1 Tally 2 Output 

0 0 1 

0 1 0 

1 0 0 

1 1 1 
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The logic operator adds tallies sequentially as they are added to the list.   
 
E.g.  (Tally 1 OR Tally 2) AND Tally 3  - then  [(Tally 1 OR Tally 2) AND Tally 3] OR Tally 4. 
 
  
5.4 Output Logic 
 
Bitwise  
 
In the Bitwise mode the Active Tally Channel Mask boxes act as a mask for the tallies in the 
System Tally.   
 

 
 

  
 
The new System Tally 1 consists of two tallies OR’d, with a third one AND’d,  taken from the 
Parallel I/O unit tally inputs and remains gated as Program. 
 
When the Bitwise button is selected the Active Tally Channel Mask boxes must be selected 
to match the Mapped Tallies In channels. 
 
For example consider the above:  Tallies 1 and 2 are associated with the Program channel.  
The logic operator is set to AND Tally 3 with Tallies 1 and  2.  All tallies must belong to the 
same tally channel for the logic operator to work.  When the tallies are active an output will be 
available that is associated with Program.  Program must be checked in the Active Tally 
Channel Out mask for the System Tally to be output. 
 
If there were a fourth tally input associated with Iso 4 channel and this is to be OR’d with the 
result of [Tallies 1, 2 and 3], for this tally to be output, Iso 4 must be checked too in the Active 
Tally Channel Out mask. 

Output Logic. 
 
Bitwise outputs the 
tallies according to 
the logic operator. 
Input Tallies must be 
in the same Active 
Tally Channel. 
 
Logical 
 If both tallies are 
active, then the 
channels ticked in 
the output box will 
be active (the input 
channel associations 
are ignored) 
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Logical 
 
The logical operator acts in the same way for the input tallies as described for Bitwise but the 
important difference is that the output may be mapped to a different  Active Tally Channel 
Out from any of the input tallies, if desired.  
 
 

  
 
In this example, the tallies are output in Active Tally Channel Iso3. 
 
Summary 
 
In the Bitwise mode the Active Tally Channel Mask boxes act as a mask for the tallies in 
the System Tally (“cable”).   
 
 In the Logical mode the Active Tally Channel Out boxes route the input tallies to the 
selected active channel. 
 
 
6.0 Tallies and Vision Mixers 
 
In TallyMan, vision mixers are treated exactly as though they are routers. 
 
Tallies from a mixer are not necessarily used directly.  It is possible to tally a mixer destination 
to have sources tallied correctly.  This is a use for a System Tally set to Permanently ON and 
assigned to the PGM bus. 
 
If a tally is set to a mixer / router destination, any source that the destination selects will also 
be tallied as long as the mixer outputs router status. 
 
This tallied router / mixer source may be assigned to a UMD and / or to a physical output pin 
via a Parallel I/O unit so that cameras may be tallied. 
 
The tally information coming from the actual mixer into TallyMan is read so that cross point 
information is known.  
 
Tip: Several mixer modules do have a Tally In listing.  Under these circumstances, as the 
Mixer’s internal tally mapping probably needs to be use, it is advisable to map the Tally In 
inputs to the Mixer Sources as a first step. 

In the Logical mode 
the Active Tally 
Channel Out boxes 
route the input tallies 
to a selected active 
channel. 
 
The channel  Iso 3 is 
shown here. 
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7.0 Inhibited Tallies 
 
There may be a requirement to inhibit or enable tallies from an object (e.g.) the parallel Sony 
Mixer input tallies or from the parallel tally input on the TM1, so that in an emergency, all 
tallies from the mixer or parallel inputs are inhibited. 
 
This may be done by using the Assign Enable feature. 
 
 

 
 
Without any configuration all tallies will normally be enabled in the system. 
 
Press Assign Enable. 
 

 
 
This shows that Tally 1 from the Parent called Tally has been assigned as the inhibiting tally. 
 
When Tally In 1 is active, no tallies will be output from the object called Tally In. 
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Invert Enable 
 

 
 
 
Also 
 

 
 
 
This now means that when Tally In 1 is active, tallies will only then be output from the object 
called Tally In. 
 
Notes  
 

• The Tally Mimic under Tools > Tally Mimic will always show the actual incoming tally 
status. 

• Even if an Object is inhibited, the activating tally for the inhibit function that belongs to 
that same object still remains active.  Consider the case where there are both serial 
tallies (mixer) and parallel tallies (GPIs) in the same Object.  The serial tallies are 
required to be inhibited but a parallel tally is needed for the inhibit action. 
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8.0 Tallies and Routers 
 
If a tally is set to a router destination / bus, any source that the destination selects will also be 
tallied. 
 
This tallied router source may be assigned to a UMD or to a physical output pin via a Parallel 
I/O unit such as the ESP-1/R so that cameras may be tallied. 
 
The serial information coming from the actual router into TallyMan is read so that cross point 
information is known.  
 
9.0 Tallies and UMDs 
 
UMDs may receive the tallies either directly or via associations with a router destination or 
source.  Tally Channels need to be associated with the left and right UMD LEDs etc.  Please 
see the UMD Section for further details. 
 
10.0 The Tally Map 
 
This is accessed via the View Menu and show how the tallies are routed. 
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A double mouse click on a tally line will allow direct editing of the object (e.g. router source or 
a Tally Out pin etc.) to which the tallies are mapped.  
 
 

 
 
 
 
11.0 The Tally Mimic 

 

This mimic, seen via Tools > Tally Mimic,  will show the status on incoming tallies to the 

system and the colour assigned. 

 

 

 

Select the appropriate Tally I./O in the drop down box. 
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12.0 Notes on Mixer and Router tallying 

 
Mixer Program Tally to Mixer Source Mapping 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This is the linking in TallyMan.  The box below indicates the TallyMan object.  The video path 
is shown only to show that the tallies may be regarded as running in the opposite direction to 
the actual video. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mixer 

Video 

Tally 

Map the appropriate Program 
Tally In to the appropriate Mixer 
Source in TallyMan  
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Mixer Source to Router Destination Mapping 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This is the linking in TallyMan. 
 
It will be seen that any UMDs on the router will be tallied.

Mixer Router 

Video 

This path is now made in 
TallyMan because TallyMan 
knows that Mixer Source 1 is 
mapped to Router Destination 1  
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Mixer Source to Router Source Mapping 
 
This would be used where the router is a monitoring router only and is used for feeding 
monitor walls.  For example a Camera feeds the input to a router and an input to a Mixer.  
Both inputs are effectively common so the Source to Source linking is done in TallyMan.  It 
will be seen that any UMDs on the router will be tallied. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This is the linking in TallyMan.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mixer Router 

Video 

This path is now made in 
TallyMan because TallyMan 
knows that Mixer Source 1 is 
mapped to Router Source 1  
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Now map the Tally Out pin to the Router Source for the Camera CCUs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
It will be seen that due to the linking within TallyMan, the Cameras will get a Tally (cue) as 
well as any UMDs that are driven via the router information. 
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Appendix 1 
 
Tally/GPO control using Omnibus code 
 
Omnibus GPI Mapping Details 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Set the required serial port that is used for the Omnibus connection. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Setting the Tally I/O to "Omnibus" results in the physical inputs (if any) being sent to 
Omnibus, and the physical outputs being controllable by Omnibus (OBS).  
 
Omnibus can switch on or off a tally output. 
  
The inputs and outputs continue to behave as normal within Tallyman. The Tally Inputs may 
be assigned to objects as normal.   The Tally Mimic will show the physical input status. The 
Tally Outputs may be mapped as is usual. The link to OBS is effectively overlaid on top of the 
normal I/O.  
 
OBS can  “see” the input status, and can control the output status. This is where the "force 
on, force off" options are used.  OBS can force the state one way or another, overriding any 
mapping in TallyMan to that output. 
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The mapping procedure is as follows: 
 
  
 

• This protocol operates on the existing hardware parallel Tally I/O module - locate this 
module (currently set to input type "Logic Level", output type "Open Collector").  

• Select "Omnibus In" and "Omnibus Out" as hardware type.  

• Configure number of Tally Outputs as required.  

• Set the Serial Parameters on the port used to connect to Omnibus.  
  
 
The parallel tally outs are now controlled by the Omnibus GPI protocol. 
 
  
 
 
 
 
 
 
 
 
 


